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What is Endnote? 
 
EndNote is a tool for collecting, storing and managing bibliographic references. You can then 
include your references in academic writing and automatically reformat them for different 
referencing styles. 
 
 
For taught students: 
 
The Library recommends EndNote Online for taught students and new users, and provides a set 
of web pages explaining how to use it at: 
https://www.sheffield.ac.uk/library/refmant/endnoteweb. EndNote Online is web-based and 
available without charge to all members of the University of Sheffield. For full Endnote 
Training Guide see http://endnote.com/support/online-user-manual/x7 
 
For PhD students and staff: 
 
However, PhD students and ScHARR staff working on large-scale research projects are likely to 
need to use the desktop version of EndNote which provides more functionality, a greater range 
of output citation styles, and allows for sharing within teams. 
 
Currently, the desktop version of EndNote is only licensed for use on campus, though it is 
possible to purchase a personal copy for home use. 
 
This guide aims to introduce you to the features of EndNote; if you have suggestions for 
additions or corrections, please contact one of the team who created it (Andrea Shippam; Gill 
Rooney; Mark Clowes; and Louise Preston).  If you need urgent advice on EndNote issues not 
covered here, you could try the EndNote forums at: http://community.thomsonreuters.com/; 
alternatively, Liam Bullingham, the University Library’s resident EndNote expert, can be 
contacted at l.bullingham@sheffield.ac.uk. 
 
  

https://www.sheffield.ac.uk/library/refmant/endnoteweb
http://endnote.com/support/online-user-manual/x7
https://www.sheffield.ac.uk/library/refmant/guidance
http://community.thomsonreuters.com/
mailto:l.bullingham@sheffield.ac.uk
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Creating a Library 

 

Creating a library for personal use 

 
Open EndNote. 
Go to ‘New’ 
Give your library a name and choose where it will be saved.  

 
When you create your Endnote Library, there will be two separate items created – the Endnote 
Library itself e.g. LibraryTitle and a folder which is called LibraryTitle.Data 
 

Creating a shared library  

 
You may wish to do this if you are working in a project team or if you wish to share your library 
with colleagues. EndNote desktop libraries (or groups of references within them) can be shared 
using EndNote Online.  However, you can only have one EndNote online library per e-mail 
address; so rather than syncing an individual’s personal library with that of all their colleagues, 
it may be preferable to set up a new shared library associated with a generic e-mail address for 
the project.  
 
For ScHARR-TAG projects, a shared library will be set up by the project managers (Andrea 
Shippam and Gill Rooney).   All team members will receive an e-mail invitation to this library.   
 
Anyone else wanting to create a generic e-mail address for a project can do so via CiCS at: 

https://www.sheffield.ac.uk/cics/account/requestgeneric/index 
You will then need to set up an Endnote online account for the project with the project (generic) 
e-mail address.  Then create an Endnote library using these credentials and share with the 
project team.  

Sharing a library with others 

 
Before you can share a library with others, you have to sync it with the cloud. 
 

 Open the Library and go to <Edit> <Preferences> <Sync>.  
 Enter the “EndNote Account Credentials” of the account you want to share (if you 

haven’t set up an EndNote Online account you need to create one). Then click “OK” to 
save the details. 
 

After doing this click on the “Sync” button on the toolbar. This will upload the library to its 
EndNote Online account. While this is taking place a green progress indicator will be displayed 
in the bottom right of the screen. 
 
Once synchronization is complete, click on the “Share Library” button on the toolbar. Then 
enter the email address for each person you wish to share with, together with a message telling 
them about the shared library you are setting up. 
 
Each member will receive an email (from noreply@endnote.com) inviting them to join the 
shared library, by following the link in the email. 
 

https://www.sheffield.ac.uk/cics/account/requestgeneric/index
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If you later decide you want to stop other users accessing the library you can do this via the 
“Share Library” button.  
 

IMPORTANT: Reference Identification in EndNote 
 
Unlike Reference Manager which applies unique ‘Reference ID’ numbers to references, 
regardless of who is looking at the reference, when Endnote applies a ‘Record Number’ to 
your reference, this record number will differ depending upon who is looking at the 
reference – for example, Smith (2003) may be Record Number 272 in the library when 
accessed by one person and record number 343 in the library as accessed by someone 
else working on the project.  
This only applies when you are sharing a library.  

 

Opening a library that has been shared with you 

 
You will receive an email (from noreply@endnote.com) inviting you to join the shared library, 
by following the link in the email. 
 
When you follow this link, you will be asked to verify yourself by logging into your EndNote 
Online account. You can then return to EndNote desktop. 
 
In EndNote go to <File> <Open Shared Library…> and any shared libraries you can access will 
be displayed in a dialogue box for you to select.  
 
Once you have selected a library, EndNote will download the contents of this Online account 
into a new library on your desktop by using Sync. 
 
When synchronization is complete, you will have full access to the shared library. Any changes 
you make will be sent back to the Online Account when the Sync is run. At the same time, any 
changes made to the library elsewhere will be transferred to your local copy of the library. 
 
Before clicking the “Sync” button, ensure no edited references has the focus. If one did have the 
focus and unsaved edits had been made, these would not be received. 
 

Sending your Endnote library to other people 

 
If you want to send your library to others via e-mail (rather than sharing it online), you will 
need to compress your library; this gives you just one file (LibraryTitle.enlx) to send via email 
etc. 
 
Choose the “Compressed Library” option (under the File menu).  Remember - this is effectively 
creating a copy of the EndNote library, so any changes made by the recipient will not be 
reflected in the master version.  If ongoing collaboration is likely to be required, it is much 
better to create a shared library following the instructions above (Sharing A Library With 
Others). 
 

mailto:noreply@endnote.com
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Adding references to your library 

 
References can be added to your library in a variety of ways. In this guide we will show you how 
to  

 Manually enter references into your library 
 Import PDFs into your library 
 Import references from bibliographic databases 
 Import references from other reference software 
 Copy references from one library to another library.  

 

Manually entering references into your library 

 
While it is much quicker to populate your library from database searches, sometimes you will 
want to manually input known references or those identified manually via reference lists.   
To do this: 
 
Select <References> then <New Reference>, or press <CTRL+N> on the keyboard, or use the 
add new Reference button.   
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Choose the “Reference Type” by scrolling through the list.   
 
Insert the “Authors” in the format: Graham,J.  
 
After inserting the first Author press <ENTER>, then insert the second name on a separate line, 
and so on.   
 
Please note that if you need to enter an organisation as the Author, type it exactly like you want 
it to be seen in Word and add a comma at the end.  If you do not enter authors/organisations in 
this format, they will not be displayed correctly in your bibliography. 
 
Insert the “Year”, “Title”, “Journal”, “Volume”, “Issue” and “Pages” (xx-xx). 
 
Using Keywords will help you to identify groups of references at a later stage (see: Managing 
Your Library in the next chapter). 
 
Insert the “URL” if you have one.   
 
You can use the “Caption” field to indicate whether you have already obtained the full text; for 
ScHARR-TAG projects the tags used are “In File”, “Not In File”, or, if an inter-library loan has 
been ordered, “On Request”.    
 
To save your new reference, click on <File> then <Save> or <Control S>. 
 
Exit the “Reference Edit” window by clicking the “Close” (x) button in the top right-hand corner 
of this window. 
 

Importing PDFs into your Library 

 
Many research projects are inspired by a specific paper; you may also have conducted some 
informal Google / Google Scholar searching around a topic at an early stage, for scoping 
purposes. 
 
If you have already downloaded PDFs which are likely to be relevant to the project, you can 
import these from the File menu. (File – Import – File – Choose…). EndNote will attempt to 
create a record for each one; though how successfully it does this will depend on the formatting 
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of the document.  You may have to update the record manually (see above instructions on 
manually entering references). 
 

Importing references from bibliographic databases 

 
The most efficient way to populate your library with a large volume of references is to import 
records directly from a bibliographic database. 
 
The University Library maintains a set of web pages about EndNote and these include current 
information about compatibility with the databases it provides:  
https://www.sheffield.ac.uk/library/refmant/databases 
 
In some cases, direct export is possible; in others, it is necessary to download your results as a 
file in .txt or .RIS format and then import this into your EndNote Library.  You may also prefer to 
download your results as a separate file for your records, especially if you are required to report 
your search process as would be the case for a systematic review. 
 

Importing references from other reference software 

 
As Reference Manager and Endnote are now owned by the same company, instructions have 
been provided on how to do this – see http://endnote.com/support/faqs/endnote/import 
 
The University of Washington Library have provided some (unofficial) guidance on exporting 
from Mendeley http://guides.lib.uw.edu/c.php?g=99194&p=642698 
 

Copying references from one library to another 

Open up both libraries. 
Select the reference(s) you want to copy. 
On the reference tab at the top select “copy reference to” 
Select the library you want to copy into. The reference(s) will then be copied across and appear 
in a new group in the new library called “copied references”. 
 

 
 
If you are sharing the library, click “Sync” to send this change to the others sharing the library.  
 
Check you all see the additional reference(s). 

https://www.sheffield.ac.uk/library/refmant/databases
http://endnote.com/support/faqs/endnote/import
http://guides.lib.uw.edu/c.php?g=99194&p=642698
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Managing your library 

Adding keywords and labels 

 
You may wish to add your own keywords to records in your Endnote Library to help you 
retrieve them quickly at a later date. How you choose to do this is for your project team to agree, 
but it is common to use the “Keywords” fields for this purpose.  
 
To add a label 
 
If, for example, you wanted to label all the records which had been retrieved from Web Of 
Science, you could add a tag “$$WoS” or similar (using the “$$” symbol helps to differentiate 
your tag from any keywords which might already be present in the record). To find these 
records at a later stage, all you would have to do is run a search. 
 
You might also use keywords when sifting through records, labelling those which meet your 
inclusion criteria with “$$Include”. 
 
To add a keyword to a large number of records simultaneously, first you need to create a 
discrete group of all the records you want to label. If you have just imported them from a 
database, they will automatically be grouped together in a set called “Imported References” (you 
can find this in the menu on the left hand side of the screen).  If you need to create a group based 
on other criteria, you will need to use “Search” (located under the Tools menu) to identify them; 
then you can perform your labelling function on your “search results”. 
 
To add a tag to your full set of search results, click on ONE of them to highlight it.   Then, go to 
Tools – Change/Move/Copy Fields. After each label or keyword you add, make sure you enter a 
carriage return - this will ensure that it is kept separate from other terms and remains easily 
searchable. 
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Choose the field into which you want to add your keyword(s). 
 
It may be helpful to add your terms before any others which are already in that field (in which 
case, include a space afterwards); or you may prefer to add them at the end (in which case, add 
a space before). Remember to press ‘Enter’ (carriage return) after each keyword. 
 

Managing your keywords  

 
Often when people tag references in Endnote, they like to use a predefined list of keywords e.g. 
‘$$louise-include-diabetes’ and have a number of different keywords to add. Some reference 
management software will autocomplete your keywords for you when you are adding them into 
the Keywords field. Endnote does not do this, but it is possible to retrieve a list of the keywords 
you have added by going to ‘Tools’ and selecting ‘Open terms list’ and then a list of the terms 
that you have added will then appear so you can check what you have used. The keywords will 
now automatically autocomplete when you are typing in the keywords field.  
 

Removing duplicate references 

 
There are a number of ways of removing duplicates from your EndNote library.  Unfortunately, 
the automatic duplicate checking facility only works well if all the references have been entered 
in a similar format.  Since this is not usually the case, it will be necessary to supplement this 
with a manual check for duplicates. 
 
To run the automatic checker, select <References> <Find Duplicates>. This will display a 
dialogue box, either saying there are none, or showing the pairs side by side so you can resolve 
them (there is also a “Duplicate References” group created). When they are side by side, any 
differences are highlighted and you can decide which to keep. You can also drag and drop any 
missing information from one side to the other. 
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You can alter the fields used to compare possible duplicates, e.g.: page number, to help you 
identify true duplicates. To alter the settings, select <Edit> <Preferences> <Duplicates>. Select 
all the boxes you would like to scan e.g.: start page, volume number, etc.  You can mark as many 
or as few as you like. Sometimes it is easier to just have Title and Authors checked as this gives 
you less restriction (but you may find multiple outputs from the same study e.g. a conference 
abstract and then a peer-reviewed article). When finished with changes, click <OK> to save. 
 

 
 
Behind the dialogue box, in the ”Duplicate References” group, EndNote highlights the 
references it thinks are duplicates. It is best not to delete these highlighted references but to use 
the dialogue box to make educated decisions on possible duplicates. 
 
When you have finished identifying and removing true duplicates and leaving the false 
duplicates (by clicking the “Skip” button), the dialogue box will close. The “Duplicate 
References” group will be displayed, showing the false duplicates, this can be closed by right 
clicking on the group name and selecting “Delete Group”. 
 
Once you have finished removing duplicates, it is still wise to actually scan the references 
manually as some of the duplicates are not picked up by the automatic check because they are 
slightly different. To do this, you need to sort by Author on the main database, by clicking 
“Author” at the top of the column in the reference list area. This may take several seconds, 
depending on the amount of records in your library. Another useful check would be to sort by 
Title. 
 

Groups and Smart Groups 

 
You can create as many Groups as you like to manage your references.   References are manually 
filed into groups and you can add them to more than one group   If you wish to move a reference 
from one group to another, please remember to delete the record from the first group – 
otherwise it will simply be copied across. 
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The All References number stays the same even though you are moving references to the 
different groups and the Unfiled number shows you how many are still to be added to a Group.   
 

   
 
Smart Groups 
Smart Groups automatically put records with certain pre-defined terms into the group – e.g. a 
certain keyword. You create the definition of your Smart Groups. 
 

 

Find full text feature 

 
Endnote has a “Find Full Text” feature. This means that when you insert a reference into 
Endnote, it will automatically search the web for a PDF version of the reference and add the PDF 
to your library. This process happens every time that you open the library - Endnote will search 
for the full text of any articles that do not have a PDF attached. This can be a very useful feature, 
however when you have a large library, this feature will slow down the functionality of Endnote. 
 

 

When Endnote has found PDFs of papers in your library it indicates this by adding a little 

paperclip next to the reference.  It is possible for you to manually add PDFs into the library, if 

you wish to store them within your Endnote library.  To do this you click on the attach “PDFs 

button” to the right of the screen and then click onto the paperclip next to it.  This allows you to 

search for the relevant paper, in much the same way as adding an attachment to an email. 
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Similarly, if you have a very large library, you may wish to detach all the papers and store them 

somewhere different as a lot of attachments may make the library run slowly.  To do this go to 

Windows File Manager,  

   
and select the location of your Endnote library.  Open up the Data folder and then select the 

"PDF" folder for the library.  

 

In the search box (top right), type in "*.pdf" this will search for all pdfs from this letter down. 

Once the search has completed, select them all, copy them, then paste where you need them.  

Then delete them from the folder in the Endnote Data folder.  NB: this won’t work for shared 

libraries – this will need to be done by the person who shared the library with you. 

Searching within your library 

 
Make sure you are in the <All References> group, and click the “Show Search Panel” button 
(top right). 
 
In the first drop down box select the field you wish to search, e.g. “Keyword”.   
 
Leave the next column as “Contains”, then add the search term into the last column, e.g. 
“$$Medline”. 
 
 

 
 
Within the Search window you can perform more complex searches, by combining different 
parameters together using the drop down boxes for Boolean logic (AND/OR/NOT) and the tick 
boxes for “Match Case” and “Match Word”. 
 
Click on the “Search” button or press [Enter] on the keyboard. 
 
The results are displayed in a new group, called “Search Results”.  
 

Using Endnote to search the web for references 

 
If you are using Endnote on a computer which is connected to the internet, you can search using 
the Endnote search interface to locate references that are not already stored in your library. 
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This is no substitute for comprehensive searching on a database (e.g. Medline) but it can help to 
fill gaps or quickly find the full details and abstract of known papers. 
 
Select the Endnote Online search button from the toolbar  
 

 
 
Choose a database (if in doubt, ‘PubMed’ is a good bet) in the Groups panel. Then fill in the 
Endnote search fields, remembering to select the type of field that you want to search (e.g. 
author, title etc). When you search, a dialog box will give you the number of records retrieved 
from your search. You can decide whether to retrieve these references or refine your search.  
 
The references retrieved will be stored in a temporary library and need to be moved to one of 
your permanent libraries or groups, by using the ‘Copy to Local Library’ button.  
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Exporting references into Microsoft Word / Excel 

 
Exporting references into Word 
To get a list of records with title and abstract from your EndNote library, select the references 
that you want  (either via a search and “Edit” “Select All”, or “Control A” or by individually 
selecting the appropriate references) by Control and clicking on desired references. You may 
wish to do this to create a Word document for sifting, or to create a list of references or 
bibliography, without using Cite While You Write.  
 
Go to the style drop down box and Select Annotated 
Go to “Edit” and “Copy Formatted” 
Open Word document and then paste “CTRL+V” 
 

 
 
Exporting references into Excel 
You may wish to import your Endnote Library to EXCEL for sifting or other purposes. The best 
approach for this is to get a list of records with title and abstract from your EndNote library, 
select the references that you want  (either via a search and “Edit” “Select All”, or “Control A” or 
by individually selecting the appropriate references) by Control and clicking on desired 
references. 
 
Then Go to the style drop down box and select ‘Tab delimited’ and save the file. Then open 
EXCEL. Go to File / Open then choose the file you saved from Endnote. The Text Import Wizard 
will open. Keep all the settings as they are. More information is available at  
https://www.youtube.com/watch?v=FTdy1BOg2KQ 
 

Generate Inter Library Loans (ILLs) 

From your EndNote library, select the references that you want to request (either via a search 
and “Edit” “Select All”, or “Control A” or by individually selecting the appropriate references) 
by Control and clicking on desired references. 
 
Go to the style drop down box on the toolbar and select the “ILL Merge” style from the list  
If you do not see this style, you may need to copy the file “ILL Merge.ens”* to 
 C:\Program Files (x86)\EndNote X7\Styles. 
 
Go to <Edit> <Copy Formatted>. This copies the selected references into the Windows 
clipboard in this special style. You will then need to open the “ILL Merge List.xlsx”* Excel file. 
Put your cursor in cell “A2” and paste by pressing “CTRL+V”. The reference data should ppear 
in the correct columns. 
 
You then need to use this data to populate the Article Request Form* using Mail Merge in 
Microsoft Word. 
 
*All these files are linked from 
https://www.sheffield.ac.uk/scharr/sections/ir/library/library_services under “Reference 
Management” 
 

https://www.youtube.com/watch?v=FTdy1BOg2KQ
https://www.sheffield.ac.uk/polopoly_fs/1.703626!/file/ILL_Merge.ens
https://www.sheffield.ac.uk/polopoly_fs/1.703629!/file/ILL_Merge.xlsx
https://www.sheffield.ac.uk/polopoly_fs/1.703628!/file/ILL_Request_Form.doc
https://www.sheffield.ac.uk/scharr/sections/ir/library/library_services
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Using Endnote for reviews or report writing 

Using Endnote for review projects 

 
Before you start a review project, it would be worth agreeing the following with your research 
team  
 

 Keywords - Where these keywords are going to be entered (keywords field or labels 
field) Note: we have had some issues with libraries becoming corrupted and EndNote 
recommended this was less likely to happen if we all use keywords NOT labels. 

 Ensure that there is a keyword for all references retrieved and how these references 
were retrieved to facilitate the PRISMA statement. 

 Standardise your approach to duplicate references (tag these as duplicates? put in the 
bin and leave them there? move to a duplicates group? remove permanently from the 
database?) 

 

Sifting tips for reviewers 

 

 By default, you will see a grey dot next to each record in your EndNote library.  This is 

the “Read / Unread” indicator and can be used to indicate quickly whether you have 

already viewed that record.  You can also sort a group of records, or your whole library, 

according to read/unread status. 

 If you are sifting within EndNote, you may find it helpful to change the columns which 
are displayed.  Go to Edit / Preferences and then select “Display Fields”.  If you want to 
change display fonts, these can also be modified from the same menu. 

 

Inserting citations directly into your report 

 
Please use ‘Cite While You Write’ (CWYW). 
 
Before starting ensure “Enable Instant formatting” is “unchecked”.  
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Open your Word document and click the “Insert Citation” button.  
 

 
 
Type ‘Author’ and click “Find”. 
 
Choose the correct reference from those displayed and click “Insert”. 
 
If you wish to cite more than one reference in the same place, simply select them all from the list 
and click “Insert”. If you have already inserted one, then want to add another to it, make sure 
your cursor is adjacent to the last one already cited and insert the other one. Then tidy up the 
citation so it looks like “{Graham, 2004 #35;Grem, 2004 #24}”. Note the single set of “{}” and 
the “;” to separate citations.  
 
To change the citation style choose the “Style” drop down box on the EndNote ribbon. If the 
style you require is not in this favourites list, select “Select another style…” and pick it from the 
full list. 
 

 
 
 
Click on Update Citations and Bibliography to produce a reference list. Make sure that the Font 
and Size corresponds to that of the rest of the document. (The reference list will take on the 
formatting of the last line of the document, so make sure that before you insert any citations, the 
last line is normal formatting, not a heading.) 
 
If you need to remove a reference for any reason, you need to put your cursor on the citation 
and go to the “Edit & Manage Citation(s)” button. In the list that appears, select the citation 
you wish to remove from the document, click on the black triangle on its right edge and select 
“Remove Citation”. When you click “OK” the dialogue box will close and the document will 
update. 
 
If you notice an error in one of your references you can correct this by going to “Edit & Manage 
Citation(s)”. Find the reference you wish to edit and click “Edit Reference”, this will open the 
reference in EndNote Desktop where you can edit and save it before returning to Word. Finally 
click on “Update Citations and Bibliography” to apply the changes you have made. 
 
If you require further assistance with inserting EndNote citations into Word, CiCS have provided 
some ‘EndNote Tips’ in response to frequently asked questions: 
https://www.sheffield.ac.uk/cics/endnote 
 

https://www.sheffield.ac.uk/cics/endnote
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Creating a PRISMA diagram 

 
If you are using the PRISMA reporting system (http://www.prisma-statement.org/), you might 
find it useful to create a group for each of the stages of the flow diagram, starting with the 
number of citations identified by the searches, following deduplication. In the group add all of 
the relevant citations.  Then, for each subsequent stage of PRISMA, create an appropriately 
named group in which to copy references from the total number of citations folder. Copying 
citations in and out of these folders as decisions are made regarding study inclusions will 
facilitate putting together the final PRISMA flow chart for your review.  
 

Creating a bibliography 

 
As you enter references into your report using Cite While You Write, EndNote will automatically 
create a list of these at the end of the document, organized in alphabetical or numerical order 
depending on which output style you have selected.  (You can reformat this list at any time by 
using the pull-down menu and clicking on “Update Citations and Bibliography”.) 
 
Should you wish to include items in your bibliography which you have read but not cited, simply 
add these to the document in the usual way, then right click on the citation and select “Edit 
citation" then “Show only in Bibliography”. 
 
If you require further assistance with inserting EndNote citations into Word, CiCS have provided 
some ‘EndNote Tips’ in response to frequently asked questions: 
https://www.sheffield.ac.uk/cics/endnote 
 
 

Andrea Shippam, Gill Rooney, Mark Clowes, Louise Preston and Suzannah Bridge 
 

May 2017 

http://www.prisma-statement.org/
https://www.sheffield.ac.uk/cics/endnote

